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Introduction

Welcome to Adobe Dreamweaver CS4 On Demand, a visual
quick reference book that shows you how to work efficiently
with Dreamweaver CS4.  This book provides complete cover-
age of basic to advanced Dreamweaver skills.

How This Book Works
You don’t have to read this book in any particular order.
We’ve designed the book so that you can jump in, get the
information you need, and jump out. However, the book does
follow a logical progression from simple tasks to more com-
plex ones. Each task is presented on no more than two facing
pages, which lets you focus on a single task without having
to turn the page. To find the information that you need, just
look up the task in the table of contents or index, and turn to
the page listed. Read the task introduction, follow the step-
by-step instructions in the left column along with screen illus-
trations in the right column, and you’re done.

What’s New
If you’re searching for what’s new in Dreamweaver CS4, just
look for the icon: New!. The new icon appears in the table of 
contents and throughout this book so you can quickly and
easily identify a new or improved feature in Dreamweaver
CS4. A complete description of each new feature appears in
the New Features guide in the back of this book.

Keyboard Shortcuts
Most menu commands have a keyboard equivalent, such as
Ctrl+P (Win) or A+P (Mac), as a quicker alternative to using
the mouse. A complete list of keyboard shortcuts is available
in the back of this book and on the Web at
www.perspection.com.

How You’ll Learn

How This Book Works

What’s New

Keyboard Shortcuts

Step-by-Step Instructions

Real World Examples

Workshops

Adobe Certified Expert

Get More on the Web
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Step-by-Step
Instructions
This book provides concise step-
by-step instructions that show you
“how” to accomplish a task. Each
set of instructions includes illus-
trations that directly correspond to
the easy-to-read steps. Also
included in the text are time-
savers, tables, and sidebars to
help you work more efficiently or
to teach you more in-depth infor-
mation. A “Did You Know?” pro-
vides tips and techniques to help
you work smarter, while a “See
Also” leads you to other parts of
the book containing related infor-
mation about the task. 

Real World Examples
This book uses real world exam-
ple files to give you a context in
which to use the task. By using
the example files, you won’t waste
time looking for or creating sam-
ple files. You get a start file and a
result file, so you can compare
your work. Not every topic needs
an example file, such as changing
options, so we provide a complete
list of the example files used
throughout the book. The example
files that you need for project
tasks along with a complete file
list are available on the Web at
www.perspection.com.

Real world
examples help
you apply what
you’ve learned
to other tasks.

Illustrations
match the
numbered
steps.

Numbered
steps guide
you through
each task.

Did You Know? alerts
you to tips, techniques
and related information.

See Also points you to
related information in
the book.

Easy-to-follow
introductions
focus on a
single concept.
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The Workshop
walks you through
in-depth projects
to help you put
Dreamweaver to
work.

Introduction xix

Logo indicates a
task fulfills one or
more Adobe
Certified Expert
objectives.

Workshops
This book shows you how to put
together the individual step-by-
step tasks into in-depth projects
with the Workshop. You start each
project with a sample file, work
through the steps, and then com-
pare your results with a project
results file at the end. The Work-
shop projects and associated files
are available on the Web at
www.perspection.com.

Adobe Certified Expert
This book prepares you fully for
the Adobe Certified Expert (ACE)
exam for Adobe Dreamweaver
CS4. Each Adobe Certified Expert
certification level has a set of
objectives, which are organized
into broader skill sets. To prepare
for the certification exam, you
should review and perform each
task identified with a Adobe Certi-
fied Expert objective to confirm
that you can meet the require-
ments for the exam. Throughout
this book, content that pertains to
an objective is identified with the
Adobe Certified Expert logo and
objective number next to it.
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Get More on the Web
In addition to the information in
this book, you can also get more
information on the Web to help
you get up to speed faster with
Dreamweaver CS4. Some of the
information includes: 

Transition Helpers
◆ OOnnllyy  NNeeww  FFeeaattuurreess..

Download and print the new
feature tasks as a quick and
easy guide.

Productivity Tools
◆ KKeeyybbooaarrdd  SShhoorrttccuuttss..

Download a list of keyboard
shortcuts to learn faster ways
to get the job done. 

More Content
◆ PPhhoottooggrraapphhss.. Download

photographs and other
graphics to use in your
Dreamweaver documents. 

◆ MMoorree  CCoonntteenntt.. Download
new content developed after
publication.

You can access these additional
resources on the Web at
www.perspection.com.

Additional
content 
is available
on the Web. 

Additional
content 
is available
on the Web. 
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Working Within the
Dreamweaver Environment

Introduction

Getting to know the Dreamweaver authoring environment
makes you more effective and efficient as you create Web
pages and manage Web sites. You’ll get to know the parts 
of the Dreamweaver window, which include toolbars and
panels. 

The Toolbars contain buttons that you can use to perform
common tasks. Dreamweaver comes with four toolbars. The
main one is the Document toolbar, which appear by default.
The Document toolbar appears under an open document tab
and allows you to change views, specify a title, manage files,
preview pages, enable or disable page view options, and per-
form document validation. The Dreamweaver window also
included panels. Panels are windows that allow you to view,
organize, and change elements and related options in a docu-
ment. The Insert panel provides the commands for inserting
various types of objects. The Properties panel is a specialized
panel that allows you to change object specific attributes and
options.To work efficiently in Dreamweaver you need infor-
mation about the active document. Dreamweaver displays
current information about the active document and common
display tools on the Status bar, located at the bottom of the
document window. For example, working with the Zoom tool
on the Status bar gives you one more way to control the
view size to exactly what you see in Dreamweaver. In addi-
tion, you can use rulers, guides, and the grid to help you lay
out artwork and objects with precision. 

Dreamweaver uses built-in keyboard shortcuts designed
specifically for Dreamweaver. The built-in keyboard shortcuts
are organized into sets, which you can duplicate and cus-
tomize to create your own personalized set. Dreamweaver
allows you to set preferences to customize the way you work
in the program. 3

3
What You’ll Do

Examine the Dreamweaver Window

Work with Toolbars

Resize Panels

Work with Panels

Dock and Undock Panels

Group and Ungroup Panels

Create a Workspace

Use the Status Bar

Change the View with the Zoom Tool

Work with Rulers

Work with the Grid and Guides

Create Keyboard Shortcuts

Set General Preferences

Set New Document Preferences

Work with Colors

Set Highlighting Color Preferences

41
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When you start Dreamweaver, the program
window displays several windows of varying
sizes you can use to create Web pages. These
windows include the Program window,
Document window, various panels, and the
Properties panel. Depending on your installa-
tion and previous program usage, not all of

these windows may appear, or additional
ones may be visible. You'll do the bulk of your
work in Dreamweaver with these windows. 

In Dreamweaver, windows appear in the
workspace with a title bar, such as the pro-
gram window, a document window tab, or in
a panel. 

Examining the Dreamweaver Window

Document Window
Displays open Dreamweaver
documents, panels, and the
Properties panel.

Panel 
Windows
Gives you access
to authoring tools
and attribute
settings for
elements.

Properties panel
Displays information about the properties and
attributes of tools and graphic elements. 
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Chapter 3 Working Within the Dreamweaver Environment 43

The PPrrooggrraamm  wwiinnddooww displays a Title bar with
the program name Adobe Dreamweaver CS3
and the filename of the active open file in
brackets. The Title bar also contains a Close
button and resizing buttons to the far right. 

A menu bar appears below the title bar
with menu names. A mmeennuu is a list of com-
mands that you use to accomplish specific
tasks. A ccoommmmaanndd is a directive that accesses
a feature of a program. Dreamweaver has its
own set of menus, which are located on the
menu bar along the top of the Dreamweaver
window. On a menu, a check mark identifies a
feature that is currently selected (that is, the
feature is enabled or on). To disable (turn off)
the feature, you click the command again to
remove the check mark. A menu can contain
several check marked features. A bullet (Win)
or diamond (Mac) also indicates that an
option is enabled, but a menu can contain
only one bullet-or diamond-marked feature
per menu section. To disable a command with
a bullet or diamond next to it, you must select
a different option in the section on the menu.

When you perform a command frequently,
it's faster, and sometimes more convenient, to
use a shortcut key, which is a keyboard alter-
native to using the mouse. When a shortcut
key is available, it is listed beside the com-
mand on the menu, such as A+F3 (Mac) or
Ctrl+F3 (Win) for the Properties command on
the Window menu.

Below the menu bar is the Insert toolbar,
which appears by default and provides tabs
with a variety of different buttons. A TToooollbbaarr
contains a set of commonly used buttons you
can quickly access to help you to create Web
pages. Dreamweaver comes with five differ-
ent toolbars, which you can show or hide to
customize the Program window

The DDooccuummeenntt  wwiinnddooww displays open
Dreamweaver documents. Dreamweaver uses
tabs to make it easier to switch back and forth
between documents. Below a Document tab
is the Document toolbar. Each document win-
dow includes a Minimize, Maximize, and
Close button at the top, and a SSttaattuuss  bbaarr  at
the bottom, which displays current informa-
tion about the active document and common
display tools.

A ppaanneell is a window you can collapse,
expand, and group with other panels, known
as a panel group, to improve accessibility and
workflow. A panel appears with a shaded
header bar, which includes the window title
and additional options. A panel group con-
sists of either individual panels stacked one
on top of the other or related panels organ-
ized together with tabs, such as the Files
panel, to navigate from one panel to another.
Dreamweaver provides a wide variety of pan-
els you can use to work with different aspects
of a Web page, including CSS Styles,
Databases, Tags, and Frames, which you can
open and close from the Window menu. As
you open, close, and move around windows
and panels to meet your individual needs,
you can save the location of windows and
panels as a custom panel layout set, which
you can display again later. 

The PPrrooppeerrttiieess  ppaanneell, known more com-
monly as the PPrrooppeerrttyy  IInnssppeeccttoorr, at the bot-
tom of the Program window provides a
convenient way to view and change attributes
of any selected object or multiple objects,
such as graphics and shapes, on a Web page.
After you select an object, relevant com-
mands and associated fields for it appear in
the Property Inspector.
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Working with
Toolbars

Show and Hide Toolbars

◆ To display a toolbar, click the View
menu, point to Toolbars, and then
click a toolbar to select the check
mark. 

TIMESAVER You can also
right-click (Win) or Control+click
(Mac) any of the toolbars and then
click a toolbar.

◆ To hide a toolbar, click the View
menu, point to Toolbars, and then
click a toolbar to deselect the
check mark. 

TIMESAVER To display or hide
the Insert toolbar, press Ctrl+F2, or
click the Window menu, and then
click Insert.

Toolbars contain buttons you can click to carry out commands you use
frequently. Dreamweaver provides 4 different toolbars—Style
Rendering, Document, Standard, and Coding—and the Insert panel for
you to use to execute commands. The Insert panel provides the com-
monly used commands for inserting various types of objects. The Insert
panel, displays subpanels, such as Common, Layout, Forms, Data, Spry,
Text, and Favorites, you can use to access buttons. The Style Rendering
toolbar allows you to work with different media types. The Document
toolbar appears by default under an open document tab and allows you
to change views, specify a title, manage files, preview pages, enable or
disable page view options, and perform document validation. The
Standard toolbar provides common file and editing commands, such as
Open, Save, Print, Cut, Copy, Paste, Undo, and Redo. The Coding toolbar
is available in Code and Split views and makes it easier to work with
code. You can quickly show or hide the toolbars you need or are no
longer using to customize the way you use Dreamweaver.

Click to select (show) or
deselect (hide) the
check mark.
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Chapter 3 Working Within the Dreamweaver Environment 45

Resizing Panels

Minimize and Maximize Panels

◆ To minimize or maximize a docking
channel, click the Double-arrow
button at the top of the panel
group. 

The double-arrow direction
indicates whether the panel
minimizes or maximizes. 

For example, if the double-arrow
points to the left of the Tools panel
that means when you click it the
Tools panel minimizes. If the
double-arrow points to the right
that means when you click it the
Tools panel maximizes.

◆ To have an expanded panel icon
automatically collapse or hide
when you click away, right-click
(Win) or control-click (Mac) a
panel, and then click Auto-
Collapse Icon Panels or Auto-
Show Hidden Panels (New!). 

If you need more workspace, you can use the double-arrow button (at
the top of a panel group) to quickly minimize a panel group, such as the
one on the right side of the Dreamweaver window. When you click the
double-arrow button, the panel group collapses to icons, which
increases the size of the workspace. You can click the icons to display
the panel. When you click the double-arrow button again, the panel
group reopens. If you need to increase or decrease the size of a dock-
ing panel, you can drag the resize bar at the top-left side of the panel
group to resize it as you would any window.

Double-arrow button;
maximized panel

Double-arrow button; minimized panel

Drag to resize panel

Click a button to display a panel
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Working with Panels

Open and Close a Panel

Click the Window menu.  

Click a panel name, such as
Properties, Files, History, or CSS
Styles.

TIMESAVER To close panels or
panel group, right-click (Win) or
option-click (Mac), and then click
Close or Close Group.

2

1

Panels are windows that allow you to view, organize, and change ele-
ments and related options in a document. In Flash, you work with sev-
eral panel windows at one time. Instead of continually moving, resizing,
or opening and closing windows, you can collapse or expand individual
panels within a window with a single click to save space. A panel
appears with a header, which includes the tab titles and three accessi-
bility options: the Minimize/Maximize button, the Close button, and an
Options menu. The entire set of panels includes a double arrow you
can use the collapse and expand the entire panel between icons with
text and full panels. You use the Minimize/Maximize button to collapse
or expand panels. The Options menu provides you with panel specific
commands, including group, rename, maximize, close a panel, and use
the Help system.

Panels on Window menu

1
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Chapter 3 Working Within the Dreamweaver Environment 47

Collapse and Expand a Panel

To collapse or expand an open
panel, click the header bar or
double-click the title tab on the
header bar of the panel.

TIMESAVER To hide and show
all panels, click the Window menu,
and then click Hide Panels.

TIMESAVER To Auto-Collapse
Icon Panels or Auto-Show Hidden
Panels, right-click (Win) or option-
click (Mac), and then select a
command.

Use the Panel Options Menu

Open or expand a panel.

Click the Options menu on the
right side of the panel header bar.  

Click a command from the list
(commands vary). Common
commands include:

◆ Help. Accesses Flash Help.

◆ Close. Closes the currently
displayed tab in the panel.

◆ Close Group. Closes all the tabs
in the panel.

3

2

1

1

3

1

2

Collapsed panels

Expanded panel

1

C03DWCS4.qxp  10/15/2008  8:05 PM  Page 47



48

Docking and
Undocking Panels

Dock a Panel

Position the pointer on the panel
tab or panel set header bar.

Drag the window away from the
panel to a panel.

◆ Add to Panel. Drag to a panel
until a blue rectangle appears
around the panel.

◆ Append to Panel. Drag to a
panel until a blue line appears
along the side of the panel.

Undock a Panel

Position the pointer on the panel
tab or panel set header bar.

Drag the window away from the
panel to an empty area of the
Dreamweaver window.

2

1

2

1

You can dock and undock, or temporarily attach and detach, panels or
panel groups. You can display panels using the Window menu, and then
drag them around the program window to dock or undock them to other
panels. You can even dock or undock the Properties panel. However,
document panels cannot be docked. When you drag a panel over a
dockable area, an outline around the target dock appears. When you
release the mouse button, the panel snaps to the dockable area and
stays there until you move it. You can even drag a panel tab to a new
position. If you attempt to dock a panel over an undockable area, no
outline appears. 

2

1

1

2

C03DWCS4.qxp  10/15/2008  8:05 PM  Page 48



Chapter 3 Working Within the Dreamweaver Environment 49

Grouping and
Ungrouping Panels

Group Panels Together

Position the pointer on the panel
tab or panel set header bar.

Drag the window away from the
panel to another panel window.

◆ Add to Panel. Drag to a panel
until a blue rectangle appears
around the panel.

◆ Append to Panel. Drag to a
panel until a blue line appears
along the side of the panel.

Ungroup Panels

Position the pointer on the panel
tab or panel set header bar.

Drag the window away from the
panel to an empty area of the
Dreamweaver window.

2

1

2

1

You can group panels together to improve organization and workflow.
When you group panels together, you can stack one on top of the other,
or group related panels together as a tabbed panel group, such as the
Component Inspector panel. You can add a panel to an existing panel
group or you can create a new panel group. If you no longer need pan-
els grouped together, you can ungroup them. You can use the panel
gripper to group or ungroup as well as dock or undock panel windows. 

2

2 1

1

See Also
See “Working with Panels” on page 46
for information on using panels, or
“Docking and Undocking Panels” on
page 48 for information on moving 
panels around the screen.
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Creating a Workspace

Create a Workspace

Open and position the panels you
want to include in a panel set.

Click the Window menu, point to
Workspace Layout, and then click
New Workspace.

TIMESAVER Click the
Workspace menu on the menu bar
(Win) or title bar (Mac) to access
workspace commands.

The New Workspace dialog box
opens.

Type a name in the Name box.

Click OK.

The panel set is now saved.

Display a Workspace

Click the Window menu, point to
Workspace Layout or click the
Workspace menu (New!), and
then select a panel option:

◆ Custom Panel Name. Displays a
custom panel layout in which
you created.

◆ Predefined Layouts. Displays
the default panel layout
(New!): App Developer, App
Developer Plus, Classic, Coder,
Coder Plus, Designer, Designer
Compact, or Dual Screen.

1

4

3

2

1

As you work with Dreamweaver, you'll open, close, and move around
windows and panels to meet your individual needs. After you customize
the Dreamweaver workspace, you can save the location of windows
and panels as a custom workspace. You can create custom work-
spaces, or use the default ones provided by Dreamweaver (New!),
such as Designer, Code, Dual Screen, and App Developer. If you no
longer use a custom workspace, you can remove it at any time. You can
also rename a custom workspace to better recognition and use. 

2

1

34

1

Workspace menu with panel name
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Chapter 3 Working Within the Dreamweaver Environment 51

Delete a Workspace

Click the Workspaces menu, and
then click Manage Workspaces.

The Manage Workspace dialog
box opens.

Select the panel set you want to
delete.

Click Delete.

Click Yes to confirm the deletion.

Click OK.

The panel set is now deleted.

Rename a Workspace

Click the Workspaces menu, and
then click Manage Workspaces.

The Manage Workspace dialog
box opens.

Select the panel set you want to
rename.

Click Rename.

Type a new name, and then click
OK.

The panel set is now renamed.

Click OK.5

4

3

2

1

5

4

3

2

1
5

3

2

5

3

2

4

Did You Know?
You can hide all panels. Click the
Window menu, and then click Hide
Panels to select the check mark.
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Using the Status Bar

Use the Status Bar

View the display information or click
a tool on the Status bar:

◆ Tag Selector. Shows the
hierarchy of tags surrounding the
current selection.

◆ Select Tool. Use to enable or
disable the Select tool.

◆ Hand Tool. Use to drag a
document into the Document
window.

◆ Zoom Tool. Use to increase or
decrease the magnification level
for a document.

◆ Set Magnification. Use to select a
predefined magnification level.

◆ Window Size. Use to resize the
Document window to a
predefined value in Design view.

◆ Document Size And Estimated
Download Time. Shows the
estimated document size and
download time for the page.

1

To work efficiently in Dreamweaver you need information about the
active document. Details about the document's size and estimated
download time all help in the design and preparation of the page.
Dreamweaver displays current information about the active document
and common display tools on the Status bar, located at the bottom of
the document window. The Status bar displays the Tag selector for the
current selection and the estimated document size and download time,
and allows you to use the Select, Hand, or Zoom tools, set document
magnification, or resize the Document window.

Tag selector Status bar

Select

Document Size/
Download TimeSet MagnificationHand

Window SizeZoom Encoding
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Set Windows Size and
Connection Speed from the 
Status Bar

Click the Dreamweaver (Mac) or
Edit (Win) menu, and then click
Preferences.

Click the Status Bar category.

Set the options you want:

◆ Window Sizes. Specify the
window sizes you want to
appear in the Status bar.

◆ Connection Speed. Select the
connection speed (in kilobits
per second) you want to use to
calculate the download size
that appears in the Status bar. 

Click OK.4

3

2

1

3

2 4

Did You Know?
You can display the download size for
an image. When you select an image,
the image’s download size appears in
the Properties panel.
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Working with the Zoom tool gives you one more way to control exactly
what you see in Dreamweaver. The Zoom tool does not change the
active image, it only lets you view the image at different magnifications.
The Zoom tool is located on the Status bar, and resembles a magnifying
glass. Increasing the magnification of an image gives you control over
what you see and gives you control over how you work. Large docu-
ments are difficult to work with and difficult to view. Many documents,
when viewed at 100 percent, are larger than the maximized size of the 
document window. When this happens, viewing the entire image
requires reducing the zoom.

Changing the View
with the Zoom Tool

Zoom In or Out the View

Select the Zoom tool on the Status
bar. 

Use one of the following methods
to zoom in:

◆ Click On The Document. The
image increases in
magnification centered 
on where you clicked. 

◆ Drag To Define An Area With
The Zoom Tool. The image
increases in magnification
based on the boundaries of the
area you dragged. 

TIMESAVER Press Ctrl+=
(Win) or A+= (Mac) to zoom in.

To zoom out, hold down the Alt
(Win) or Option (Mac) key, and
then click on the screen to reduce
the zoom of the active document.

The zoom reduction centers on
where you click on the active
document.

TIMESAVER Press Ctrl+- (Win)
or A+- (Mac) to zoom out.

3

2

1

1
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Carpenters know that precise measurements are essential to making
things fit, so they have a rule: Measure Twice, Cut Once. In keeping
with the idea that precise measurements are essential, Dreamweaver
gives you ruler bars. Ruler bars are located on the top and left sides of
the active document window. Rulers serve a very important role. Ruler
guides help you correctly align design elements. As a matter of fact, if
you're not working on a flat glass or LCD monitor, the curvature of the
monitor can give you a false impression of the vertical and horizontal.
By using guides you have access to precise alignment systems. 

Working with Rulers 

Work with Rulers

Click the View menu, and then
point to Rulers.

Select the options you want:

◆ Show. Click to show or hide the
ruler.

TIMESAVER Press Ctrl+Alt+R
(Win) or A+Option+R (Mac) to
show or hide the ruler.

◆ Reset Origin. Click to set the
ruler back to the default.

◆ Change the Origin. Drag the
ruler-origin icon (at the
upper-left corner) anywhere
on the page.

◆ Pixels, Inches, or Centimeters.
Click to select the type of
measurement you want to
appear on the ruler.

TIMESAVER Right-click in the
ruler bar to open a menu you can
use to change the measurement
system.

2

1
1

2

Did You Know?
You can choose what type of
Point/Pica size to use. Click Postscript
(72 points/inch) or click Traditional
(72.27 points/inch). Postscript is more
widely used, and Dreamweaver
defaults to this option.
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Dreamweaver comes with guides, grids, and rulers to help you lay out
artwork and objects with precision. A grid is a series of crisscrossed
lines that aid in aligning objects to each other on the Stage. A guide is
a horizontal or vertical line you can position to align objects. Grids and
guides are modifiable. You can change their visibility, position, color,
and frequency. To align several elements to a grid or guide line, you
first turn Snap to Grid or Snap to Guides on. Then you can drag the ele-
ments to align them to the grid or a guide. These items are invisible by
default, but they can be easily turned on and adjusted. Though you see
them in the Dreamweaver development environment, they are invisible
on the viewable page. Use guides to align art and objects to each other
on vertical or horizontal paths, or turn on the grid for use in designing a
layout that is proportional and balanced.

Working with the 
Grid and Guides 

Use the Grid

Click the View menu, and then
point to Grid.

Select the option you want:

◆ Show. Click to show or hide the
grid.

TIMESAVER Press Ctrl+Alt+G
(Win) or A+Option+G (Mac) to
show or hide the grid.

◆ Snap To Grid. Click to enable or
disable objects aligning to a
grid line.

TIMESAVER Press
Ctrl+Alt+Shift+G (Win) or
A+Option+Shift+G (Mac) to
enable or disable Snap To Grid.

◆ Grid Settings. Click to open the
Grid Settings dialog box, where
you can set the grid color,
settings, spacing, and display,
either lines or dots.

2

1
1 2

Grid Settings
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Use Guides

Click the View menu, point to
Guides, and then select the
options you want:

◆ Show Guides. Click to show or
hide the guides.

◆ Snap To Guides or Guides Snap
To Elements. Click to enable or
disable objects aligning to
guides or guides to objects.

◆ Edit Guides. Click to set the
guide color, distance color, and
other settings.

◆ Lock Guides. Click to lock the
existing guides in place.

◆ Clear Guides. Click to remove
all guides.

Move to the vertical or horizontal
Ruler bar, and then click and drag
into the document.

Click the Select tool on the Status
bar to drag existing guides to a
new position (make sure Lock
Guides is not selected).

3

2

1
1

23

Edit Guides

Did You Know?
You can remove one guide at a time.
Make sure Lock Guides is clear, and
then click the Select tool. Drag the
existing guide you want removed back
to the corresponding Ruler bar.

You can use keyboard shortcuts to
work with guides. A+; (Mac) or Ctrl+;
(Win) shows and hides guides,
Option+A+; (Mac) or Ctrl+Alt+; (Win)
locks and unlocks guides, Shift+A+;
(Mac) or Ctrl+ Shift+; (Win) to turn
Snapping to guides on and off, and
Shift+A+/ (Mac) or Ctrl+Shift+/ (Win)
to turn Snapping guides to elements on
and off.

Setting Precise Measurements Using Guides

If you want to use exact measurements while you work with guides to
create a Web page design, you can set guides to a precise location
or view the exact distance between guides. To view and move a
guide to a specific location, double-click the guide, enter the exact
location you want, and then click OK. To view the distance between
guides, press Ctrl (Win) or  (Mac), and hold down the mouse pointer
anywhere between the two guides. The unit of measure that appears
is the same as the unit of measure for the rulers.

For Your Information
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Creating Keyboard
Shortcuts

Create a Keyboard Shortcut Set

Click the Dreamweaver (Mac) or
Edit (Win) menu, and then click
Keyboard Shortcuts.

Click the Current Set popup, and
then select a set.

Click the Duplicate Set button.

Type a name for the new shortcut
set.

Click OK.5

4

3

2

1

Dreamweaver uses built-in keyboard shortcuts designed specifically
for Dreamweaver. A complete list of the keyboard shortcuts is available
in the back of this book. The built-in keyboard shortcuts are organized
into sets, which you can duplicate and customize to create your own
personalized set. If you use other programs, such as Adobe Illustrator
or Adobe Photoshop, and you are more comfortable using their key-
board shortcuts for common commands, you can select a built-in key-
board shortcut set from any of the graphics programs to use in
Dreamweaver.

2

5

3

Delete button

4

Did You Know?
You can delete a custom keyboard
shortcut set. Click the Dreamweaver
(Mac) or Edit (Win) menu, click
Keyboard Shortcuts, select a shortcut
set from the Current Set popup, and
then click the Delete button. You can-
not delete a built-in keyboard shortcut
set that comes with Dreamweaver.

You can rename a custom keyboard
shortcut set. Click the Dreamweaver
(Mac) or Edit (Win) menu, click
Keyboard Shortcuts, select a shortcut
set from the Current Set popup, click
the Rename Set button, enter a new
name, and then click OK. You cannot
rename a built-in keyboard shortcut set
that comes with Dreamweaver.
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Add or Remove a Keyboard
Shortcut

Click the Dreamweaver (Mac) or
Edit (Win) menu, and then click
Keyboard Shortcuts.

Click the Current Set popup, and
then select the set in which you
want to change.

Click the Commands popup, and
then select a shortcut category,
such as Drawing Menu
Commands, Drawing Tools, Test
Movie Menu Commands, and
Workplace Accessibility
Commands.

Select the command for which you
want to add or remove a shortcut
in the Commands list.

Do the following:

◆ To add a shortcut, click the Add
Shortcut (+) button, and then
press the key combination to
enter the new shortcut key in
the Press Key box.

◆ To remove a shortcut, click the
Remove Shortcut (-) button.

Click Change.

To add or remove additional
shortcuts, repeat Steps 2-6.

Click OK. 8

7

6

5

4

3

2

1

2

5

Keyboard shortcut

4

3

6

8

Export keyboard shortcuts as HTML

You can now export Dreamweaver keyboard shortcuts as an HTML
file that you can view and print using a standard Web browser. To
export the keyboard shortcuts, click the Dreamweaver (Mac) or Edit
(Win) menu, click Keyboard Shortcuts, click the Current Set popup,
select the set you want, click the Export Set As HTML button, enter a
file name, specify a location, and then click Save.

For Your Information
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Setting General
Preferences

Set General Preferences

Click the Dreamweaver (Mac) or
Edit (Win) menu, and then click
Preferences.

Click the General category.

Select from the following options:

◆ Open Documents In Tabs
(Mac). Select to open all
documents in a single window
with tabs. 

◆ Show Welcome Screen. Select
to show welcome screen
(Default on).

◆ Reopen Documents On Startup.
Select to open any documents
that were opened the last time
you closed Dreamweaver
(Default off).

◆ Warn When Open Read-Only
Files. Select to get an alert
when you open a locked file
(Default on).

◆ Update Links When Moving
Files. Specify the action you
want: Prompt (Default), Never,
Always.

◆ Show Dialog When Inserting
Objects. Select to prompt you
when inserting objects using
the Insert bar or Insert menu.

TIMESAVER To temporarily
override this setting, Ctrl-click
(Win) or A-click (Mac) when
creating and inserting objects.

3

2

1

Dreamweaver allows you to set general preferences to customize the
way you work in the program. You can specify what you want to display
or open when you launch Dreamweaver and how you want to edit con-
tent. Some of the preferences allow you to show or hide the Welcome
Screen, allow multiple consecutive spaces when editing, use CSS or
HTML tags when formatting, specify to the number of history steps
(undo levels), and select a spelling dictionary.

2

3

C03DWCS4.qxp  10/15/2008  8:07 PM  Page 60



Chapter 3 Working Within the Dreamweaver Environment 61

◆ Enable Double-Byte Inline
Input. Select to enter double-
byte text, such as Japanese
characters (Default on).

◆ Switch To Plain Paragraph
After Heading. Select to press
Enter (Win) or Return (Mac)
after a heading paragraph to
switch to a plain paragraph in
Design view (Default on).

◆ Allow Multiple Consecutive
Spaces. Select to allow typing
two or more spaces in Design
view to create nonbreaking
spaces that appear as multiple
spaces in a browser (Default
off).

◆ Use <strong> And <em> In
Place Of <b> And <i>. Select to
apply <strong> instead of <b>
and <em> instead of <i>
(Default on). 

◆ Use CSS Instead Of HTML Tags.
Select to use CSS when you
use the Properties panel’s Style
option, except for bold and
italic (HTML) (Default on).

◆ Warn When Placing Editable
Regions Within <p> Or
<h1><h6> Tags. Select to
display a warning when you
save a template when true
(Default on).

◆ Centering. Select the option you
want when you click the Align
Center button in the Properties
panel (Default <div>).

◆ Maximum Number Of History
Steps. Specify the number of
steps the History panel keeps.

◆ Spelling Dictionary. Click to
select a dictionary language.
The dialect is in parenthesis.

Click OK.4

3

4
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Setting New
Document 
Preferences

Set New Document Preferences

Click the Dreamweaver (Mac) or
Edit (Win) menu, and then click
Preferences.

Click the New Document category.

Select from the following options:

◆ Default Document. Select the
type of document you want to
use as default (Default HTML).

◆ Default Extension. Enter the file
extension you want to use for
the HTML extension, either
.html or .htm. (Default .html).  

◆ Default Document Type (DTD).
Select to the XHTML document
type definition (DTD) you want.

◆ Default Encoding. Specify the
encoding you want to use for
new documents and opened
documents without any
specified encoding. This makes
sure your Web browser and
Dreamweaver use the right
character set for the selected
language. The default for HTML
encoding is Unicode (UTF-8),
which safely represents all
characters.

3

2

1

When you create a new document, Dreamweaver allows you to set the
default document type you want. The New Document preference
options allow you to specify the default document, extension, document
type definition (DTD), and file encoding. DTD allows you to select
XHTML 1.0 Transitional or XHTML 1.0 Strict to make new Web pages
XHTML-compliant. File encoding makes sure your Web browser 
and Dreamweaver use the right character set for the selected 
language.

2

3
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◆ Use When Opening Existing
Files That Don’t Specify An
Encoding. Select to apply
encoding to when you open a
file without encoding.

◆ Unicode Normalization Form. If
you select Unicode (UTF-8) for
encoding, select the form
option you want: C, D, KC, or
KD. Form C is the most common
one used for the Web in the
Character Model. The others
are provided by Adobe. 

◆ Include Unicode Signature
(BOM). If you select Unicode
(UTF-8) for encoding, you can
select this option to include a
Byte Order Mark (BOM), which
is a 2-4 bytes at the beginning
of a text file that identifies a file
as Unicode, and order the
bytes. This is optional.

◆ Show New Document Dialog
Box On Control+N. Select to
show the New Document
dialog box or clear to
automatically create a
document with default settings
when you use the shortcut key
Ctrl+N (Win) or A+N (Mac).

Click OK.4

3

4
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Since Web pages appear in Web browsers,
you want to use colors on your pages that
are Web-safe, so they appear consistently on
every browser. A WWeebb--ssaaffee  color appears the
same in Microsoft Internet Explorer and
Netscape Navigator on both Windows and
Macintosh system when running in 256-color
mode. 

RRGGBB (red, green, blue) is a set of color val-
ues that describe colors. RGB identifies a
color by a set of hexadecimal numbers, an
internal computer numbering scheme, that
specify the amounts of red, green, and blue
needed to create the color. RGB colors
appear best over the Web (true color repre-
sentation without dithers or substitutes)
when you use only bbrroowwsseerr  ssaaffee  ccoolloorrss,
which is a standard set of 216 color combina-
tions. These RGB values are 0, 51, 102, 153,
204, or 255 in decimal or 00, 33, 66, 99, CC,
or FF in hexadecimal. When you use the sys-
tem color dialog boxes, you use decimal val-
ues. You use hexadecimal values in Code
view, the Properties panel, and some dialog
boxes, such as the Preferences dialog box. 

Using the Color Picker
When you want to change a color, you can
click any color box available in many dialog
boxes, such as the Preferences dialog box,
and the Property Inspector to open the color
picker. The color picker allows you to select a
color for different page elements.

When you click a color box, the color
picker appears, displaying the eyedropper
cursor and a palette with a bar at the top and
a swatch of colors at the bottom. The bar dis-
plays the currently selected color and its
hexadecimal number. To the right is the
DDeeffaauulltt  CCoolloorr  bbuuttttoonn, which clears the current

color without choosing a different color. Next
to the Default Color button is the CCoolloorr  WWhheeeell
bbuuttttoonn, which opens the system color picker.
The system color picker is the standard color
selector provided by the operating system,
either Windows or Macintosh. The popup
menu in the upper-right corner of the color
picker allows you to expand your color selec-
tion. You can select different color palettes,
including Color Cubes, Continuous Tone,
Windows OS, Mac OS, and Grayscale. The
Color Cube (default color palette) and
Continuous Tone palettes are Web-safe while
the Windows OS, Mac OS, and Grayscale are
not. If you are using a non Web-safe palette,
you can use the Snap To Web Safe command
to have Dreamweaver replace the selected
color with the closest Web-safe color. You can
use the eyedropper to select a color swatch
from the palette or pick a color from any-
where on your screen inside or outside
Dreamweaver.

Working with Colors

Color palettes

Default color Color wheel

Color Picker
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Using the System Color Picker
When you click the Color Wheel button in the
color picker, a system color picker dialog box
opens. In Windows, you can use the Color
dialog box, which displays basic and custom
color squares and a color matrix with the full
range of colors in the color spectrum, to help
you select a color. You can enter RGB (Red,
Green, Blue) values or hue, saturation, and
luminosity (also known as brightness) values
to specify a color. HHuuee is the color created by
mixing primary colors (Red, Blue, and
Yellow). SSaattuurraattiioonn is a measure of how
much white is mixed in with the color. A fully
saturated color is vivid; a less saturated color
is washed-out pastel. LLuummiinnoossiittyy is a meas-

ure of how much black is mixed with the
color. A very bright color contains little or no
black. You can also change the hue by moving
the pointer in the color matrix box horizon-
tally, the saturation by moving the pointer
vertically, and the luminosity by adjusting the
slider to the right of the color matrix box. On
the Macintosh, you click one of the color
modes and select a color, using its controls.
You can select RGB values by selecting the
color sliders at the top of the dialog box; or
by entering values (color numbers) to select
a color. You can select hue, saturation, and
brightness (or luminosity) values by selecting
the color sliders at the top of the dialog box
or entering values (color numbers). The color
you select appears in the ColorSolid box.

Drag to select color

Drag to select color range

RGB

HSL

C03DWCS4.qxp  10/15/2008  8:07 PM  Page 65



66

You use the Highlighting section of the Preferences dialog box to spec-
ify the colors you want to use for the following items in Dreamweaver:
Mouse-Over, Editable regions, Nested editable, Locked regions, Library
items, Third-party tags, or untranslated or translated live data. You can
select the color you want by using a color swatch or entering a color id
number in Hexadecimal (Hex). In addition, you can also determine
whether you can show or hide your color selection.

Setting Highlighting 
Color Preferences

Set Highlighting Color
Preferences

Click the Dreamweaver (Mac) or
Edit (Win) menu, and then click
Preferences.

Click the Highlighting category.

Click the color box and select a
color or enter a color Hex number
for the options you want.

Select or clear the Show check
box next to an option to show or
hide the color selection.

Click OK.5

4

3

2

1

2

4

53
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Index

A
abbreviations, defining, 123
absolute paths, 165
absolute positioning of AP elements, 246
accessibility, 451

adding accessibility, 467
HTML Reports options, 468
preferences, setting, 466
Remote Info options, 478-481

access keys
for form objects, 305
for links, 169

acronyms, defining, 123
actions. See behaviors; events; snippets
ActionScript files, 79
activating Dreamweaver, 15
active link colors, 83
Active Server Pages, 79

showing/hiding tags, 89
Active Server Plus Pages files, 79
ActiveX controls, using, 292-293
Add Behavior button, 351
addpro Web site, 8
Adobe. See also Flash; Illustrator;

Photoshop
activating Dreamweaver, 15
downloading applications, 13
help resources, 37
manuals, 340

Adobe Acrobat Connect, 298
starting meetings with, 298

Adobe Bridge, 30-31
Adobe Contribute, 475
Adobe CSS Advisor Web site, 234
advanced find and replace. See

finding/replacing
Advanced Site Definition Web site, 473

setting definitions, 474-475
advertising banners, 134
AIF files, linking or embedding, 288
Ajax framework help, 37
albums. See photo albums
alert dialog box

text, displaying, 362
alias of application, creating, 14
alignment. See also tables

for ActiveX objects, 293
AP elements, 253
CSS properties, setting, 224
elements

anchor points, showing/hiding, 89
AP elements, 253

for Flash/Shockwave movies, 283
forms, image buttons in, 311
with grids and guides, 56
of horizontal rules, 109
images, aligning, 146-147
for Java applets, 291
options for, 146-147
of paragraph text, 106

alpha masks, 149
alternate content

ActiveX objects, images for, 293
for Java applets, 291
text, using, 467

<alt> tags, 469
anchors. See named anchors
AP elements

aligning, 253
borders, showing/hiding, 244
dragging, 368-369
for image map hotspots, 178
introduction to, 242
manually changing CSS-P 

positioning, 246
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AAPP  eelleemmeennttss  ((ccoonnttiinnuueedd))
manually creating, 243
moving, 253
naming, 248
nesting, 244
outlines, 87
overlapping, preventing, 252
preferences, setting, 245
previewing positioning, 251
properties, modifying, 250-251
resizing, 253
rollovers with, 254-255
Show/Hide Elements action, 348
showing/hiding anchor points for, 89
stacking order

changing, 252
modifying, 253

styles, creating, 247
tables, converting to, 256-257
working with, 252-253
z-index, applying, 249

appearance page properties, setting, 82
appear/fade, 358

spry effects, adding, 396
Apply Source Formatting option, 342
arrow keys in Code view, 513
ASP file tags, inserting, 337
ASP.NET file tags, inserting, 337
ASPX format, 29
assembling site, 7
assets, 408. See also color assets; libraries;

templates; URL assets
favorite assets, working with, 414-415
Favorites folder, grouping assets in, 415
inserting, 410
modifying assets, 411
multiple assets, selecting, 411
previewing, 410
sorting, 414

Assets panel
documents from templates, creating, 24
images, inserting, 134
opening templates from, 430
resizing, 414
working with, 409

attachments. See also templates

external style sheet, attaching, 218
attributes. See also CSS (Cascading Style

Sheets)
legal characters in values, 345

audience
demographic studies, 7
planning for, 3

audio files, linking or embedding, 288-289
autoplay. See Flash
autostretch. See tables
AVI files, linking or embedding, 288

B
Background File Activity dialog box, 495
backgrounds. See also CSS (Cascading

Style Sheets); Flash; tables
of AP elements, 245
properties, setting, 82

balanced code, checking for, 460-461
bandwidth, 472
base tag, 330
Basic Site Definition Wizard, 473
behaviors, 347-348. See also events

changing event for behavior, 355
deleting, 357
downloading third-party behaviors, 352
editing, 364-355
effects, adding, 358-359
entire page, applying to, 352-353
introduction to, 347-349
multiple behavior order, changing, 356
page elements, applying to, 350-351
parameters, editing, 354

Behaviors panel, 350-351
Benguiat font, 91
blank Web page, creating, 21
blinds, 358

spry effects, adding, 396
block snippets. See snippets
<body> tag, 352-353
boldfacing

characters in text, 104
with Copy and Paste Special, 101
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copying/pasting, setting for, 102
for headings, 84
for links, 83
table text, 195

BOM (Byte Order Mark), selecting, 63
Box model, 251
borders. See also CSS (Cascading Style

Sheets); Flash; frames and framesets;
tables

AP element borders, 
showing/hiding, 244

Change Property behavior for, 366
braces < >, 322

balance, checking for, 460-461
Coding toolbar options, 332

brightness of images, 152
broken links, finding and fixing, 452-454
browser compatibility, 458-459

CSS browser compatibility, checking for,
234-235

testing, 351
Browser Compatibility Check (BCC), 234-

235, 458-459
browsers

Check Browser action, 348
Code view

compatibility, checking for, 458-459
scripts, inserting browser-safe, 345

colors, browser-safe, 64
editing list of, 35
events, support for, 349
independence, testing for, 451
no frame support, information for

browser with, 265
previewing in, 34-35
relative path for new links, previewing,

166-167
<b> tag, 115, 322
buffers for Flash video, 285
bulleted lists. See ordered/unordered lists

C
cache files

for file/asset information, 477
for link information, 182-183

Call JavaScript behavior, 373
captions. See also Flash elements

table captions, entering, 191

cascading Document window, 39
case sensitivity

of file names, 27
finding/replacing with, 121, 519, 521
of links, 477
for tag find and replace, 521
for text find and replace, 519

cells. See tables
centering

AP elements, centering tables with, 256
paragraph text, 106
selecting options for, 61

CFML files, 29
help, 37
tags, inserting, 337

Change Link Sitewide command, 184
Change Property behavior, 366-367

with text, 361
Change Property Restore behavior, 366

with text, 361
characters, 345. See also case sensitivity

CSS character style, applying, 217
formatting, 104-105
forms, options for, 306
other characters, inserting, 96-97
special characters, inserting, 96

checkboxes. See forms
Check Browser action, 348
checking in/checking out site files, 498-499
Check Plug-in behavior, 296-297, 348

Web page, applying to, 353
class ID for ActiveX objects, 293
cleaning up. See HTML (Hypertext Markup

Language)
click and drag for text, 98
click release shift click for text, 98
client-side image maps. See image maps
cloaking/uncloaking, 474, 504

defining site cloaking, 484
closing

panels, 46
Web pages, 39

closing tags, 322
extra closing tags, deleting, 344

code. See also HTML (Hypertext Markup
Language); libraries; snippets

for Java applets, 291
for spry effects, 397
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Code Coloring section, Preferences dialog
box, 346

Code Hints popup menu, 328-329
Code Inspector, 325
Code Navigator, 332-333, 338
coder-oriented workspace (Windows), 325
Code view, 30, 31. See also browsers; Tag

inspector
accessing, 324
arrow keys in, 513
assets, dragging, 410
attribute values, legal characters in, 345
balanced tags, checking for, 330
with Code Inspector, 325
Code Navigator, 332-333, 338
Code View Live, 32, 326
Coding toolbar, 332-333
color preferences, setting, 346
comments

deleting, 333
inserting, 331

copying/pasting in, 331
entering HTML in, 328
fonts, selecting, 128
format preferences, setting, 342, 343
head tags, working with, 330
hint preferences, setting, 343
options, setting, 327
Reference panel, accessing in, 341
rewriting preferences, setting, 344
syntax of code, 334
Tag Chooser, using, 337

Code View Live, 32, 326
Coding toolbar, 44, 332-333
ColdFusion. See also CFML files

file formats, 79
help, 37
showing/hiding tags, 89

collapsing. See expanding/collapsing
color assets

displaying, 409
new color asset, adding, 412
text, applying color to, 413

Color Cubes palette, 64
Color dialog box, 64
color picker, 64-65

colors. See also backgrounds; color assets;
Flash; highlighting; tables; text

of AP elements, 245
code color preference, setting, 346
frame border colors, modifying, 274
for headings, 84
for image placeholders, 160-161
images, optimizing colors for, 148-149
for links, 83
palettes, selecting, 64
table colors, setting, 203
unused colors, removing, 149
Web-safe colors, 64
working with, 64-65

Color Sliders, 65
Color Wheel button, 64
columns and rows. See also CSS

(Cascading Style Sheets); tables
File View Columns options, 485
photo albums, designating columns 

for, 287
commands, 43

managing History commands, 515
recording commands, 516
running History commands, 514
saving History panel steps as, 512-513
temporary use, recording/playing com-

mands for, 516
Commands menu, Apply Source Formatting

option, 342
comments. See also Code view; HTML

(Hypertext Markup Language)
Coding toolbar, removing comments 

in, 333
showing/hiding, 88

compatibility. See also browser 
compatibility

AP element compatibility, setting, 245
Contribute feature and, 475

complete storyboards, 9
completion of site, 2-3
Component Inspector panel, 49
connection speed, setting, 53
containers, displaying text in, 362
Continuous Tone palette, 64
contrast of images, 152
Contribute feature, 475
Copy File As dialog box, 135
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copying/pasting, 100-101
code, 331
Fireworks images, 140-141
History panel steps between documents,

copying, 511
image map hotspots, 178
Photoshop images, 136-137
preferences, setting, 102
snippets, 405

cropping
images, 150, 154

CSS (Cascading Style Sheets), 29, 67, 209.
See also AP elements; forms

advanced styles, 211, 231
attaching external style sheet, 218
attribute style, 210

creating, 214
backgrounds

setting, 224
styles, changing settings for, 250

borders
properties, setting, 225
styles, changing settings for, 251

breakdown of, 210
browser compatibility, checking for, 234,

458-459
character (inline) style, applying, 217
classes, 211

for tables, 203
code formatting preferences, 236-237
Coding toolbar options, 333
colors for ID selector, 232
with Copy and Paste Special, 101
copying/pasting, setting for, 102
creating Web page with CSS layout, 212-

213
CSS rules, 216-217

modifying existing rule, 226
moving, 228-229
Relevant CSS tab, using, 230

custom CSS layouts, 213
default properties, 81
deleting

CSS rule, 227
design-time style sheets, 239
internal style, 220

design-time style sheets, using, 239

embedded CSS code, formatting, 237
entire style sheet, modifying, 227
external styles, 211

attaching external style sheet, 218
creating, 215
modifying external style sheet, 219

file formats, 79
fonts

for ID selector, 232
setting, 224

formatting code preferences, setting,
236-237

hidden content, displaying, 89
hover class, 231
HTML (Hypertext Markup Language)

compared, 210
ID selectors

applying, 233
creating, 232
working with, 231

introduction to, 242
manually formatting CSS code, 237
paragraph style, applying, 216
with photo album index page, 287
preferences

code formatting preferences, setting,
236-237

styles preferences, setting, 238
properties, setting, 224-225
Properties panel, 222-223
pseudo-classes, 231
Relevant CSS tab, using, 230
sample pages with, 25
sample style sheet, using, 219
selecting, 61
selector declaration, 226

name, changing, 227
shorthand preferences, setting, 238
showing/hiding style sheets, 239
spry widgets, editing, 378
styles

creating, 214-215
paragraph style, applying, 216

Styles panel, using, 221
tag style method, 210-211
text style, creating and applying, 116-117
types of styles, 211
visual aids, using, 87
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CSS-P (Cascading Style Sheets-Positioning),
245. See also AP elements

applying styles, 248
creating styles, 247
manually changing, 246
properties, modifying, 250-251

CSS Rule Definition dialog box, 224
CSS rules. See CSS (Cascading Style

Sheets)

D
data files for ActiveX objects, 293
dates and times, adding, 97
decorative fonts, 96
Default Color button, 64
default images folder, 477
definition lists

creating, 112
modifying, 113

deleting. See also CSS (Cascading Style
Sheets); tables; templates

behaviors, 357
closing tags, 344
columns in site, 485
commands, 515
favorites, 414
Flash Video component, 285
font combinations, 103
frames, 271
guides, 57
HTML comments, 333
library items, 421
links, 181
menu bar items, 385
properties, 367
remote files, 502
shortcuts/shortcut sets, 58-59
site files or folders, 74
snippets, 405
spry effects, 396-397

demographic studies, 7
description tag, 330
Design Notes, 474

columns, associating, 485
enabling, 486
erasing, 486

linking with files, 487
viewing, 488

design-time style sheets, using, 239
Design view, 30, 31, 324

assets, dragging, 410
comments in, 331
Reference panel, accessing in, 341
visual aids in, 87

Device Central. See Adobe Device Central
dictionaries, selecting, 61
diff tool, 496-497
digital cameras. See Adobe Bridge
disabled options, 43
discovery sites, 7
dither for images, 148
docking/undocking panels, 48
documents

History panel steps between documents,
copying, 511

importing/exporting document 
data, 94-95

links to Microsoft documents, 95
new document preferences, 

setting, 62-63
paths, document-relative, 165
size, displaying, 52
from templates, 24
untitled documents, list of, 469
viewing multiple documents, 31

Document toolbar, 44
Document window

cascading and tiling, 39
examining, 42-43
resizing, 52

double-byte inline input, allowing, 61
double-clicking on text, 98
downloading. See also Flash

Adobe applications, 13
behaviors, 352
estimated download time, displaying, 52
image download size, displaying, 53
images affecting time, 143
snippets, 401
statistics preferences, 472
templates, 428

drag-and-drop
assets, 410
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CSS rules, 229
external JavaScript library items, drag-

ging, 423
Drag AP Element behavior, 368-369
Draw AP Div tool, 243
Dreamweaver API reference, 37
Dreamweaver Exchange Web site, 469
DTD (document type), 62

selecting, 85
dynamic form elements, 300
dynamic images, 134
dynamic pages, 69
dynamic text, showing/hiding, 89

E
editable regions. See templates
editing, 404-405. See also Flash; images

Browser list, 35
external JavaScript scripts, 425
Fireworks images, 141
jump menus, 317
library items, 418-419
Photoshop images, 138-139
properties, 367
spry widgets, 378

Edit NoFrames Content command, 265
Edit Snippet button, 404
Edit Tag mode, Quick Tag Editor in, 335
EDML files, 79
effects

behavior effects, adding, 358-359
spry effects, adding and removing, 396-

397
8-second rule, 143
elastic CSS layout, 212
elements. See also AP elements; assets;

behaviors; Flash elements; forms;
frames and framesets; invisible ele-
ments; Show/Hide Elements behav-
ior; spry widgets

accessibility, adding, 467
navigation bar elements, 174
selecting, 90

email links
adding, 170
modifying, 169-170

embedding
for ActiveX objects, 293

showing/hiding embedded styles, 88
sound files, 289

empty tags, removing, 469
<em> tag

allowing, 61
using, 115

enabled options, 43
encoding

frame encoding, changing, 272
selecting, 62
specifying encoding type, 85

errors on previewing Web pages, 34
events. See also specific events

associated events, 349
changing event for behavior, 355
specific browser, showing events 

for, 351
existing Web page, opening, 28
exiting Dreamweaver, 40
Expanded table mode, 189
expander arrow, 46
expanding/collapsing

Coding toolbar options, 332
Files panel, 71
panels, 46-47

exporting. See importing/exporting
extending Dreamweaver, help with, 37
extensions. See also Adobe Extension

Manager
CSS styles, changing settings for, 250
selecting, 62

external editors. See images
external JavaScript libraries

creating Javascript files, 422-423
dragging JavaScript library items, 423
editing scripts, 425
inserting, 424

external style. See CSS (Cascading Style
Sheets)

eyedroppers for images, 149

F
fade. See appear/fade
favorite assets

adding or deleting, 414
Favorites folder, grouping assets in, 415
nicknames, creating, 415
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file formats
different formats, saving files in, 78
list of, 79

files and folders, 67. See also dependent
files; extensions; Files panel; local
root folder; remote folders; testing
servers

closing, 39
default images folder, 477
deleting, 74
Design Notes, linking, 487
different formats, saving files in, 78
existing file, opening, 28
Flash file types, 280
HTML files, 322
image folder, defining, 132
levels of folders, displaying, 70
local root folders, 476
setting up site folders, 69
site preferences, setting, 490-491
snippet folder, creating, 406
SpryAssets folder, 376-377
Subversion, using, 500-501
templates, storing, 23
transferring files to and from remote

site, 494-495
types of files

changing, 67
list of, 29

updating links when moving files, 60
working with, 68

Files panel
creating files in, 73
customizing appearance of, 474
in expanded view, 71
finding files in, 76-77
managing files and folders in, 74-75
moving files or folders in, 75
new site folder, creating, 75
opening files in, 72
recently modified files, finding, 77
refreshing, 72
Subversion, using, 500-501
viewing files in, 70
working with, 492-493

File Synchronization, 502-503
File View Columns options, 485

filters for CSS properties, 225
finding/replacing, 120-121, 505. See also

tags
advanced find and replace

for tags, 520-521
for text, 518-519

Files panel, files in, 76-77
last search, repeating, 519
queries, creating and using, 522
recently modified files, 77
Results panel, using, 122
templates, editable regions in, 448

Find Next command, 119
Find Selection command, 119
firewalls, 479

settings for, 490-491
Fireworks, 2. See also photo albums

copying/pasting images, 140-141
editing images in, 155
GIF images with, 130
optimizing images with, 142
PNG format, 131
Script files, 79

fixed CSS layout, 212
fixed fonts, selecting, 128
fixing broken links, 454
Flash, 2.

autoplay, 285
backgrounds

for movies, 283
borders

for movies, 283
downloading

video, 284-285
editing

files, 282
Flash Video component, 285
movies, 282

file types, 280
height

for movies, 282
for video settings, 284

inserting movies, 281
names

for movies, 282
PNG format, 131
properties of movie, changing, 282-283
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URLs
for video, 284

video, inserting, 284-285
widths in movies/videos, 284

Flash Player code, 285
Flash Video files, 280
flexibility of site, 451
flow chart for site, 6
FLV format, 284-285
folders. See files and folders
fonts, 91. See also CSS (Cascading Style

Sheets); Flash; styles
Change Property behavior for, 366
changing text font, 104
for headings, 84
link font, setting, 83
modifying combinations, 103
nested font tags, combining, 463
preferences, setting, 128
setting font properties, 82
size, modifying, 105
special characters and, 96
table text, 195

formatting. See also tables
characters, 104-105
Coding toolbar options, 333
copying/pasting, setting for, 102
CSS (Cascading Style Sheets) code pref-

erences, setting, 236-237
images, 148
multiple changes, making, 105
paragraph text, 106
with Paste Special, 100-101

forms, 299
aligning image buttons, 311
buttons, 304

image buttons, inserting, 311
objects, inserting, 304
working with, 310

checkboxes
inserting, 305
modifying, 308

creating forms, 302-303
CSS rules

for buttons, 310
for image buttons, 311
for lists/menus, 309

for radio buttons/checkboxes, 308
for text fields/text areas, 307

dynamic elements, 300
creating, 312

elements, 300
dynamic form elements, 300, 312
example code for, 318

example code for, 318-319
explanation of, 300-301
GET method, 303
image buttons, inserting, 311
Input Tag Accessibility Attributes dialog

box options, 305
inserting form objects, 304-305
jump menus, 316-317
labels

for buttons, 310
for objects, 305

layout for, 303
lists/menus

inserting, 305
jump menus, 316-317
working with, 309

naming, 303
password files, creating, 307
POST method, 303
radio buttons

inserting, 305
modifying, 308

showing/hiding
delimiters, 89
fields, 88

tables for controlling, 313
text fields/text areas

inserting, 304
modifying, 306-307
type designations for, 307

Validate Form action, 348
validating, 300

example code for, 318-319
HTML form data, validating, 314-315
Validate Form action, 348

frames and framesets, 259
accessibility values, editing, 270
adding

frames, 271
frameset information, 267
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ffrraammeess  aanndd  ffrraammeesseettss  ((ccoonnttiinnuueedd))
borders, 87, 266

modifying, 273
properties, changing, 274-275

click and drag, creating frameset with,
263

colors of borders, modifying, 274
deleting frames, 271
down and dirty links, creating, 278
elements

frame elements, 261
frameset element, 260

information for browser with no frame
support, 265

inserting framesets, 263
introduction to, 260-261
names

changing, 273
link names, changing, 278
navigation bar, inserting, 277

new file, saving frames and framesets
as, 268-269

opening Web page in, 264
properties

border properties, changing, 274-275
frame properties, changing, 272-273
size properties, modifying, 275

quick frame links, creating, 278
resizing frames, 270
sample, creating frameset from, 262
saving framesets, 268-269
selecting framesets and, 266
sizing/resizing

frames, 270
frameset size properties, 

modifying, 275
targeted links, creating, 276-277
text, displaying, 362
title for frameset page, setting, 275

free association concept, 4
Freedom Scientific, JAWS for Windows, 466
Freemind Web site, 5
FTP (File Transfer Protocol)

connection options, setting, 490-491
links, 164
Remote Info categories, 478-479
Site FTP log, displaying, 495

G
gamma of image, adjusting, 131
Garamond font, 91
general fonts, 103
general preferences, setting, 60-61
GET method for forms, 303
GIF files, 29

images, 130
tracing images in, 86, 206
transparent GIFs, 256

goals of site, 2
Go To URL behavior, 348

working with, 360
graphics. See images
grids and guides. See also rulers

frame document, laying out, 262
working with, 56-57

grouping/ungrouping panels, 49
grow/shrink, 358

spry effect, adding, 396
guides. See grids and guides
GUI (graphic user interface), 16
GW Micro, Window-Eyes, 466

H
Hand tool, 52
headers and footers, snippets for, 400
headings

frame headings, changing, 272
page properties, setting, 84

head tags, working with, 330
height. See also Flash; tables

for ActiveX objects, 293
of AP elements, 245, 247
of horizontal rules, 109
image height, changing, 144, 150
for Java applets, 291

help, 36-37
hexadecimal codes, 105
hiding. See showing/hiding
hierarchical storyboards, 9
highlighting, 358

library item highlight color, 66, 420
preferences, setting, 66
spry effects, adding, 396

History panel, 505. See also commands
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clearing, 507
closing, 507
copying steps between documents, 511
defining History steps, 517
description of, 506
managing commands, 515
number of steps, changing, 61, 127, 517
opening, 506, 507
replaying steps from, 510
running History commands, 514
saving steps as commands, 512-513
undoing/redoing, 127

multiple History steps, 508-509
Undo/Redo slider, 506
workarounds for steps not recorded, 513

home page
setting page as, 80

horizontal rules
inserting, 108
modifying, 108-109

Host Directory for FTP, 478
hotspots. See image maps
HSB sliders, 65
HTML (Hypertext Markup Language), 29, 67,

321. See also Code view; Code View
Live; events; forms; frames and
framesets; named anchors; Quick Tag
Editor; spry widgets; Tag inspector

balanced code, checking for, 460-461
Browser Compatibility Check 

(BCC), 458-459
browser-safe scripts, inserting, 345
cleaning up, 462-463

Microsoft Word HTML, 464-465
comments

deleting, 333
inserting, 331

with Copy and Paste Special, 101
copying/pasting, setting for, 102
CSS (Cascading Style Sheets) 

compared, 210
description of, 322-323
explanation of, 322-323
file formats, 79
head tags, working with, 330
opening Web pages with, 28
properties, changing, 81
reports on attributes, 468

selecting, 61
shortcuts as HTML, exporting, 59
spry HTML data set, displaying, 388-389
syntax of code, 334
Tag Chooser, using, 337

HTTP address for site, 477
HTTP links, 164

adding, 168-169
hue, 64-65
hybrid CSS layout, 212

I
icons

Design Notes icons, 488
ideas, 4
IDs. See also CSS (Cascading Style Sheets)

for form objects, 305
Illustrator, 2

shortcuts, 58
image buttons in forms, 311
image maps

creating client-side image map, 176
modifying hotspots, 178
server-side image maps, 176
showing/hiding, 88

Image Preview dialog box, 141
ImageReady, 155
images, 129. See also Adobe Bridge; Adobe

Stock Photos; backgrounds;
Fireworks; frames and framesets;
Photoshop; preloading images;
rollover images; tables

accessibility options, editing, 145
aligning, 146-147
assets, displaying, 409
brightness, changing, 152
contrast, changing, 152
cropping, 150, 154
default images folder, 477
download size, displaying, 53
external editors, 155

file type, setting, 156-157
file type preferences, setting, 156-157
Fireworks images, inserting, 140-141
folder, defining, 132
inserting, 134-135
low source images, 143
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iimmaaggeess  ((ccoonnttiinnuueedd))
navigation bar, changing images to, 370-

371
optimizing, 143, 148-151
placeholder, inserting, 160-161
previewing, 150-151
Properties panel

aligning images with, 146-147
modifying with, 145

resizing, 144-145
rollover images, creating, 158-159
Set Nav Bar Image behavior, 370-371
sharpness, changing, 153
Swap Image behavior, 348, 364-365
Swap Image Restore 

behavior, 348, 364-365
tracing image, inserting, 86
URL to image, applying, 413
Web-friendly graphics, 130-131
zooming on, 151

<i> tag, 115
<img> tag, 144
importing/exporting

Microsoft document data, 94-95
shortcuts as HTML, exporting, 59
tabular data, importing, 93
table data, 196-197
templates, XML data to, 449-450

Inconsistent Region Names dialog box, 443
InContext Editing

adding CSS formatting, 441
creating editable region, 440-441
creating repeating region, 438-439
deleting, 439

indenting
code, 342
CSS source code options, 236
for HTML code, 327
for lists, 110
paragraph text, 106

InDesign. See Adobe Bridge
index.htm, 80
index page for photo albums, 287
information-gathering, 7
inheritance, 230
Input Tag Accessibility Attributes dialog box,

305
Insert HTML mode, Quick Tag Editor in, 335

Insert toolbar, 43, 44
objects, prompt on inserting, 60

Inspiration Web site, 4
installing

Dreamweaver, 13
Intel-based Macintosh systems, 11
interlaced browser display, 149
Internet. See browsers; remote site; Web

pages; Web sites
Internet Explorer, 34

ActiveX controls in, 292
events, support for, 349, 350
Web-safe colors, 64

invalid code, Coding toolbar options, 333
invisible elements, 87

selecting, 90
working with, 88-89

invisible maps, 87
IPv6 transfer mode, 479
ISP (Internet service provider), 490
italicizing

characters in text, 104
with Copy and Paste Special, 101
copying/pasting, setting for, 102
for headings, 84
for links, 83
table text, 195

J
Japanese characters, enabling inline input

for, 61
Java applets, 279

inserting, 290
preferences, modifying, 291

Java files, 79
JavaScript. See also AP elements; behav-

iors; external JavaScript libraries;
spry widgets

attaching behaviors to links, 179
Call JavaScript behavior, 373
executing, 373
files, 79
null/script links, creating, 179
rollover image name, 158, 159
showing/hiding, 88

Java Server pages, 79
JAWS for Windows, 466
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JPEG/JPG files, 29
images, 130-131
tracing images in, 86, 206

JRun custom library tags, inserting, 337
JSP files tags, inserting, 337
jump menus, 179, 316-317

editing, 317
text in, 316

justifying paragraph text, 106

K
keyboard shortcuts. See shortcuts
keywords, 4

tags, 330

L
labels. See forms
languages for spell-checking, 125
Lasso files, 79
last saved version of document, reverting

to, 27
launching Dreamweaver, 14-15
layers. See AP elements
layouts for forms, 303
Layout table mode. See tables
left alignment of paragraph text, 106
libraries. See also external JavaScript

libraries; library items; tag libraries
disconnecting library item from, 417
files, 79
introduction to, 399, 408

library items, 408. See also external
JavaScript libraries

creating, 416
deleting, 421
disconnecting item from library, 417
editing, 418-419
filename and location, displaying, 419
highlighting color preferences, setting,

66, 420
list, displaying, 409
planning for, 408
recreating missing or deleted items, 421
renaming, 421
updating on page or site, 420
using, 417

linear storyboards, 9
line breaks

for code, 342
controlling, 107
with Copy and Paste Special, 101
copying/pasting, setting for, 102
showing/hiding, 88

line numbers
Coding toolbar options, 332
for HTML code, 327

line spacing. See spacing
links, 163. See also email links; Flash; paths

automatically updating, 182
broken links, finding and fixing, 452-454
cache files, creating, 182-183
case-sensitive links, checking, 477
deleting, 181
frame links, changing, 272
for image placeholders, 160-161
menu links, adding, 385
to Microsoft documents, 95
modifying, 180
named anchor, adding, 172-173
navigation bar, inserting, 174
null links, creating, 179
opening linked pages, 185
orphan links, 184, 453
properties, setting, 83
relative path for new links, 

setting, 166-167
relative to documents, 477
script links, creating, 179
sitewide changes to, 184, 454-455
to sound files, 288
targeted links, creating, 276-277
testing, 185, 452-454
text links, adding, 168-169
types of, 164
updating, 182-183

when moving files, 60
link tag, 330
liquid CSS layout, 212
List Properties dialog box, 113
lists. See also definition lists; forms;

ordered/unordered lists
CSS styles, changing settings for, 251
modifying, 113
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LiveDocs data base, 37
Live View, 32-33
local files, 496-497
Local Info, 474

defining, 476-477
Local/Network options, 479-480
local root folder, 67, 476

creating, 11, 19
elements of site in, 18
for relative path for new links, 166
setting up, 69
working with, 68

Locate in Site command, 76-77
locked regions, color preferences for, 66
Lock Guides, clearing, 57
logical styles, 114
login for WebDAV server, 480
logos, snippets for, 400
Long Description input box, 135
long descriptions, using, 467
looping

Flash/Shockwave movies, 283
low source images, 143
luminosity, 64-65

M
Macintosh systems, 11

browsers on, 34
case sensitivity of file names, 27
color palette, 64
launching Dreamweaver in, 14-15
requirements for, 12

macros. See snippets
magnification, setting, 52
mailto links, 164
Manage Sites dialog box, 20
managing sites. See also remote site

advanced site definitions, setting, 474-
475

maps. See also image maps; site maps
mind maps, creating, 4-5

margins
frame margins, changing, 273
setting page margins, 82

marketing plans, creating, 8
maximizing. See minimizing/maximizing
meetings. See Adobe Acrobat Connect

menu bars, 43
spry menu bar widgets, 384-385

menus, 43. See also forms
spry menu bar widgets, working with,

385
merged cells. See tables
message for Flash video, 285
meta tags, 330
Microsoft Excel

importing content from, 94
links to document, creating, 95

Microsoft Word
cleaning up HTML, 464-465
importing content from, 94
links to document, creating, 95
working with, 101

MIDI files, linking or embedding, 288
MindGenius Web site, 4
mind maps, creating, 4-5
Mindmap Web site, 4
Mind tools Web site, 4
minimizing/maximizing, 43. See also

zooming; Zoom tool
panels, 45

monitors, rulers with, 55
motivation for site, 3
Mouse-Over region colors, 66
MOV files, linking or embedding, 288
movies. See also Flash; QuickTime;

Shockwave
assets, displaying, 409

moving
AP elements, 253
Coding toolbar options, 333
CSS rules, 228-229
Files panel, files or folders in, 75

MPEG files, linking or embedding, 288
MP3 files, linking or embedding, 288
multimedia. See Flash; Shockwave
multiple documents, viewing, 31

N
named anchors

adding, 172-173
links, adding, 173
showing/hiding, 88

naming/renaming. See also Flash
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ActiveX objects, names for, 293
AP elements, 248
case sensitivity of file names, 27
class names, 211
columns in site, 485
commands, 515

naming/renaming 
CSS selector declaration, 227
favorite assets, creating nickname 

for, 415
forms, 303
Java applets, names for, 291
library items, 421
Local Info, site name in, 476
local root folder, 68
panel sets, 50-51
pasting, renaming form items when, 344
photo albums, names for, 286, 287
rollover images, 158
shortcut sets, 58
snippets or snippet folders, 406
styles, renaming, 118
templates, 431
Web pages, 26
workspaces, 50-51

navigation bars
for frameset documents, 277
inserting, 174
modifying, 175, 370-371
multiple images, setting, 371
Set Nav Bar Image behavior, 179

navigation panes for photo albums, 287
nesting. See also tags; templates

AP elements, 244
lists, 110
tables, 208

Netfirms Web site, 7
Netscape Navigator. See also plug-ins

AP element compatibility, setting, 245
events, support for, 349, 350
Web-safe colors, 64

New Document dialog box
sample file designs in, 25
selecting to show, 63
template designs, selecting, 24

New Library Item button, 416
news links, 164

new Web site, creating, 18-19
nicknames for favorites assets, 415
noframe element, 261

information for browser with no frame
support, 265

Non-Breaking Space command, 96
null links, creating, 179
numbered lists. See ordered/unordered lists

O
objective of site, 3
OLE controls, 292
Omniture Web site, 7
onBlur event, 349
onClick event, 349
onDblClick event, 349
onError event, 349
onFocus event, 349
onKeyDown event, 349
onKeyPress event, 349
onKeyUp event, 349
onLoad event, 349
onMouseDown event, 349
onMouseMove event, 349
onMouseOut event, 349
onMouseOver event, 158, 348-349
onMouseUp event, 349
onUnload event, 349
Open Browser behavior, 179

working with, 361
Open dialog box for templates, 431
opening

documents with tabs, 60
Files panel, files in, 72
linked pages, 185
panels, 46
predefined sites, 20
Related Files toolbar, 339

opening tags, 322
Optimize to Size button, 149
optimizing images, 143, 148-151
ordered/unordered lists

creating, 110-111
CSS properties, setting, 225
modifying, 113
paragraph text, converting, 106
text, creating lists with, 111
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O'Reilly reference manuals, 340
orphan links, 184, 453
outdenting Coding toolbar options, 333
overlapping of AP elements, preventing,

252
Override Case of option, 342

P
page breaks, setting, 225
page positions, setting, 225
Page Properties dialog box, 69, 81

Appearance category, 82
Headings category, 84
Links category, 83
Title/Encoding category, 85

panel gripper, 46
Panel Options menu, 46-47
panels, 41, 42. See also Files panel; History

panel
docking/undocking, 48
expanding/collapsing, 46-47
grouping/ungrouping, 49
header bars, 43
information area, expanding and 

collapsing, 47
opening/closing, 46
showing/hiding, 51

panel sets, 50-51
paragraphs. See also styles

formatting text in, 106
line spacing, controlling, 107
plain paragraph after reading, switching

to, 61
parameters

for ActiveX objects, 293
for Flash/Shockwave movies, 283
for Java applets, 291

parentheses balance, checking for, 460-461
passive FTP, 479
passwords

forms, creating field for, 307
for FTP access, 478-479
for WebDAV server, 480

Paste Special command, 100-101
pasting. See copying/pasting
paths, 165

relative path for new links, 
setting, 166-167

Pewinternet Web site, 7
photo albums

creating, 286-287
index page for, 287

Photoshop, 2. See also Adobe Bridge
copying/pasting images, 137-138
editing images in, 138-139
inserting images from, 140-141
shortcuts, 58
Smart Objects, 136-139
tracing images in, 206

PHP files, 29, 79
tags, inserting, 337

physical tags, 114
placeholders for images, inserting, 160-161
planning, 1-3

mind maps, creating, 4-5
for search engine submission, 8

Play Sound action, 348
plug-ins. See also Check Plug-in behavior;

QuickTime
checking for, 296-297
inserting content, 294
playing, 295
troubleshooting, 295

PNG files
images, 131
tracing images, 86, 206

Point/Pica size, choosing, 55
Point To File icon, 173
Popup Message behavior, 348

working with, 362-363
positioning form objects, 305
POST method for forms, 303
Postscript Point/Pica size, 55
predefined sites, opening, 20
preferences. See also Code view; CSS

(Cascading Style Sheets)
accessibility preferences, setting, 466
AP element preferences, setting, 245
for copying/pasting, 102
font preferences, setting, 128
general preferences, setting, 60-61
highlighting color preferences, setting,

66
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History panel preferences, setting, 517
Java applet preferences, modifying, 291
new document preferences, 

setting, 62-63
Preferences dialog box

AP Element section, 245
Code Coloring section, 346
Code Format section, 342
Code Hint section, 343
Copy/Paste section, 102
File Types/Editors section, 156-157
invisible elements, selecting, 88-89
links, updating, 182

preloading images, 348
for navigation bars, 175
rollover images, 159
working with, 364

Preview In Browser feature, 34
previewing

assets, 410
Flash movie content, 283
images, 150-151
pages in Live view, 32-33
relative path for new links, 166-167
synchronized files, 503
Web pages, 34-35

Preview Using Temporary File option, 166
Primary Browser, 35
primary fonts, 103
printing code, 327
prioritysubmit Web site, 8
Program window, 43
Progressive Download Video, 284
properties. See also frames and framesets

adding, 367
AP element properties, 

modifying, 250-251
Change Property behavior, 366-367
CSS properties, setting, 224-225
CSS properties, in Properties panel, 

222-223
CSS-P (Cascading Style Sheets-

Positioning) properties, 
modifying, 250

deleting, 367
editing, 367

Flash movie properties, 
changing, 282-283

for image placeholder, 160-161
Shockwave movie properties, changing,

282-283
table properties, changing, 202-203

Properties panel. See also images
Crop button, 154
with spry validation widgets, 382-383

Property Inspector, 42, 43
Flash movie controls, access to, 281
proportional fonts, selecting, 128
proportions of images, resizing, 144
pseudo-classes in CSS (Cascading Style

Sheets), 231

Q
queries, creating and using, 522
quick frame links, creating, 278
Quick Tag Editor

Code Hints with, 328-329
in Edit Tag mode, 335
in Insert HTML mode, 335
opening, 334
syntax of code, 334
in Wrap Tag mode, 335

QuickTime, 279
content, inserting, 294
linking or embedding MOV files, 288

quitting Dreamweaver, 40

R
radio buttons. See forms
RA files, linking or embedding, 288
RDS (Remote Data Services) options, 481
read-only file warnings, setting, 60
RealPlayer, 288

content, inserting, 294
recently modified files, finding, 77
recently opened Web page, opening, 29
reference help, 37
Reference panel, 340-341

specific information, accessing, 341
Refresh button, Files panel, 492
refreshing Files panel, 72
refresh tag, 330
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regions. See templates
regular expressions

for tag find and replace, 521
for text find and replace, 519

Related Files toolbar, 339
relative positioning of AP elements, 246
Relevant CSS tab, using, 230
remote folders, 67

setting up, 69
working with, 68

Remote Info, 474
defining, 478-481

remote site
checking in/checking out site 

files, 498-499
comparing local and remote 

files, 496-497
file preferences, setting, 490-491
Files panel, managing files with, 492-493
transferring files to and from, 494-495

Remove Event button, 357
renaming. See naming/renaming
Rendering toolbar, 44
reopening documents on startup, 60
repeating background, setting, 82
replacing. See finding/replacing
replaying History panel steps, 510
reports

accessibility reports, creating, 467
saving, 470-471
testing sites, running reports for, 468-469
viewing, 470

Report Settings button, 468
resizing. See sizing/resizing
resizing table columns and rows, 199
Results panel, 122
rewinding Flash video, 285
RGB color mode, 64-65
Rich Internet Applications, 280

help, 37
right alignment of paragraph text, 106
rollover images

with AP elements, 254-255
creating, 158-159
customizing, 159
link colors, 83
preloading, 159

showing/hiding, 254-255
root folders, creating, 10
rulers

working with, 55

S
Safari, 34
samples

creating Web page from, 25
page sketches, 5

saturation, 64-65
Save As dialog box

different formats, saving files in, 78
file type, changing, 67

saving. See also templates
finding/replacing query, 120
framesets, 268-269
last saved version of document, revert-

ing to, 27
reports, 470-471
searches, 341
Web pages, 26-27

scaling for Flash/Shockwave movies, 283
scripts. See also external JavaScript

libraries
assets, displaying, 409
showing/hiding, 88
snippets for, 400

scrolling display, changing, 273
search engines, 8
searchenginewatch Web site, 8
searching. See finding/replacing
Secondary Browser, 35
secondary fonts, 103
secure FTP (SFTP), 479
Select All command, 99
Selection submenu, 331
selector declaration. See CSS (Cascading

Style Sheets)
Select tool, 52
servers. See also FTP (File Transfer

Protocol); testing servers
technologies, 11
URI for Flash video, 284

server-side files, 79
showing/hiding, 89

server-side image maps, 176
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Set Nav Bar Image behavior, 179, 370-371
Set Text behavior, 362
Set Text Of Status Bar behavior, 179
shading of horizontal rules, 109
shakes, 358

spry effects, adding, 396
sharing

columns in site, 485
snippets, 405

sharpness of images, changing, 153
Shockwave

assets, displaying, 409
inserting movies, 281
properties of movie, changing, 282-283

shortcuts, 3, 41
creating shortcut set, 58
deleting, 58-59
guides, working with, 57
HTML, exporting as, 59
on Macintosh systems, 15
for previewing pages, 35
for snippets, 403

shorthand CSS preferences, setting, 238
Show/Hide Elements behavior, 348

working with, 372
showing/hiding. See also forms

AP element borders, 244
columns in site, 485
CSS style sheets, 239
HTML code, hidden characters for, 327
library item highlighting, 420
panels, 51
rollovers, 254-255
table column widths, 192
toolbars, 44
visual aids, 87

single-clicking on text, 98
Site Files View, 70
site reports. See reports
site root

option, 166
relative paths, 165

sitewide link changes, making, 184, 454-455
sizing/resizing. See also Flash; frames and

framesets
AP elements, 253
Assets panel, 414

document size, displaying, 52
Flash/Shockwave movies, 282
font sizes, changing, 105
image map hotspots, 178
images, 144-145
Point/Pica size, choosing, 55
Split view, panes in, 324
Status bar, setting window size from, 53
of table text, 195

sketches of sample page, 5
skin for Flash video, 284
slides, 359

spry effects, adding, 396
Smart Objects, Photoshop, 136-139
Snap to Grid/Snap to Guide, 56
snippets

block snippets, 401
creating, 407
editing, 405

creating, 407
deleting, 405
downloading, 401
editing, 404-405
example of, 400
folder for snippets, creating, 406
inserting, 402
introduction to, 399-401
keyboard shortcuts for, 403
recent snippet, inserting, 403
renaming, 406
sharing, 405
wrap snippets, 401

adding, 403
creating, 407
editing, 405

Snippets panel, 399
sorting assets, 414
sorting table data, 201
sounds

files, linking or embedding, 288-289
Play Sound action, 348

spacer images. See tables
spacing

characters, spaces between, 96
controlling line spacing, 107
with Copy and Paste Special, 101
copying/pasting, setting for, 102
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CSS properties, setting, 224, 236
multiple consecutive spacing, 

allowing, 61
spam blockers, 168
special characters. See characters
speed

file transfer speed, 472
of site, 451

spell-checking, 124-125
dictionaries for, 61
languages for, 125

splash screens, 281
split cells. See tables
Split view, 30, 31, 324

Coding toolbar, 332-333
resizing panes in, 324
visual aids in, 87

Split Code view, 30, 31
SpryAssets folder, 376

defaults, changing, 377
Spry framework help, 37
spry regions

creating, 392-393
repeat list, creating, 394
repeat regions, creating, 392-393

spry tabbed panels, 380
spry widgets

accordion panels, 380
advanced site definitions for, 475
appearance, changing, 379
collapsible panels, 380
customizing, 395
data sets, HTML or XML, 398-391
editing, 378
effects, adding and removing, 396-397
inserting, 376-377
introduction to, 375
menu bar widgets, 384-385
regions, creating, 392-393
repeating list, 394
selecting, 378
tables, creating, 389, 391
tooltip, 386-387
validation widgets, 382-383
working with, 380-381
XML data set, identifying, 390

squishes, 359
spry effects, adding, 396

stacking order. See AP elements
Standard table mode. See tables
Standard toolbar, 44
Start menu, 29
startup, reopening documents on, 60
static pages, 69
statistics of download, gathering, 472
Status bar, 43. See also text

connection speed, setting, 53
Set Text Of Status Bar behavior, 179
using, 52
window size, setting, 53

Stock Photos. See Adobe Stock Photos
storyboards, creating, 9
streaming Flash video, 284-285
<strong> tag

allowing, 61
using, 115

Style popup, 118
styles. See also CSS (Cascading Style

Sheets); CSS-P (Cascading Style
Sheets-Positioning)

built-in text style, applying, 114-115
for characters, 104
CSS text style, creating and 

applying, 116-117
for form objects, 305
logical styles, 114
renaming styles, 118
size and font style, applying, 115
for table text, 195
turning off/on, 385

Style toolbar, 44
submission of site, 8
Subversion

enabling, 483
using, 500-501

Swap Image Restore behavior, 348
working with, 364-365

Swap Images behavior, 348
working with, 364-365

SWF format, 280
switching

between table modes, 189
between Web pages, 31

Symbols font, 96
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synchronizing
comparing files while, 497
displaying information on, 503
Local/Network options, 479-480
for RDS, 481
site files, 502-503
for WebDAV server, 480

syntax coloring for HTML code, 327
syntax error alerts in Info Bar, 333
system requirements, 12

T
tab index

for form objects, 305
for links, 169

tables, 187
adding columns or rows, 198
alignment, 203, 203

captions, aligning, 191
Layout mode, changing in, 203
of nested tables, 208
of text, 195
of tracing images, 207

AP elements to tables, 
converting, 256-257

backgrounds
cell backgrounds, formatting, 205
setting, 203, 203

borders, 87, 203, 203
cell border colors, 205

captions, entering, 191
cell padding

formatting, 202
values, 191

cell spacing
formatting, 202
values, 191

classes, 203
colors, 203

of text, 195
content to table, adding, 194-195
deleting

columns and rows, 198
empty layout cells, 191

Expanded mode for, 189
exporting table data, 196-197

formatting, 202-203
cells, 204-205
text, 195

forms, controlling, 313
header positions, 191
heights

clearing, 203, 203
modifying, 193

images
adding, 194
cells, formatting for, 205
tracing images, 206-207

importing table data, 196-197
merged cells, 200

formatting, 205
nested table, creating, 208
pixels, converting widths and heights 

to, 203, 203
placement of cells, modifying, 204
process for creating, 188
properties of table, changing, 202-203
repeating tables, creating, 435
resizing columns and rows, 199
showing/hiding column widths, 192
sorting table data, 201
split cells, 200

formatting, 205
spry tables, creating, 389, 391
Standard mode, 189

inserting table in, 190-191
nesting table in, 208
properties, changing, 202

summary, creating, 191
switching between modes, 189
Table ID, entering, 202
text

adding, 194-195
importing tabular data as, 93
wrapping text options, 205

tracing images, using, 206-207
widths

clearing, 203
fixed width, setting column to, 192
modifying, 193

working with, 188
tab size for code, 342
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Tag Accessibility Attributes dialog 
box, 382-383

alternate text, using, 467
Tag Inspector

using, 336
tag libraries, 337

descriptor files, 79
tags. See also CSS (Cascading Style

Sheets); HTML (Hypertext Markup
Language); Quick Tag Editor; tag
libraries

advanced find and replace for, 520-521
balanced tags, checking for, 460
combining nested font tags, 463
finding/replacing

advanced find and replace, 520-521
code, tags in, 341
saving tag searches, 341

nested tags
combining nested font tags, 463
fixing, 344
redundant nested tags, 469
reports testing, 468-469

physical tags, 114
selecting, 90
third-party tags color preferences, 66

Tag selector, 52, 99, 337
target audience. See audience
targets, 385. See also Flash

links, targeted, 276-277
TD tags, 342
telnet links, 164
templates. See also Assets panel

advanced site definitions for, 475
all pages, updating, 446
attachments

detaching templates, 448
opening attached templates, 431
working with attached 

templates, 448
blank template, creating, 22
creating, 429
custom templates, creating Web page

from, 445
deleting, 431

editable regions, 432
repeating region entries, 434

detaching templates, 448
downloading, 428
editable attributes, defining, 433
editable regions, 428

creating, 23, 438-441
defining, 432
finding, 447
highlighting color preferences, set-

ting, 66
nested editable regions, colors for, 66
optional regions, creating, 436-437

existing template, creating Web page
from, 24

exporting template data as XML, 449-450
file formats, 79
finding editable regions, 447
Flash template files, 280
importing XML data, 449
inconsistent region names, 443
InContext Editing

adding CSS formatting, 441
creating editable region, 440-441
creating repeating region, 438-439
deleting, 439

introduction to, 427-428
list of templates, displaying, 409
manually updating pages based on, 447
nested templates

creating, 442-443
highlighting color preferences, set-

ting, 66
Web page from, 444

non-editable optional regions, 
creating, 436

Open dialog box, opening with, 431
opening, 430-431
optional regions, creating, 436-437
relocking editable regions, 432
renaming, 431
repeating regions, creating, 392-393,

434-435
repeating tables, creating, 435
saving, 429

Web pages as templates, 27
storing templates, 23
time-saving tips for, 447
updating, 446-447
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XML data, importing and 
exporting, 449-450

testing. See also accessibility; validation
broken links, finding and fixing, 452-454
browser compatibility, 351
introduction to, 451
links, 185, 452-454
reports testing site, 468-469
servers, 474

testing servers, 67, 474
defining, 482
setting up, 69
working with, 68

text, 91. See also characters; copying/past-
ing; finding/replacing; Flash; fonts;
styles; tables

adding text to page, 92
advanced text find/replace, 518-519
colors

applying, 413
changing, 105

dynamic text, 89
for image placeholders, 160-161
in jump menus, 316
links, adding, 168-169
lists with existing text, creating, 111
for navigation bars, 175
Open Browser behavior with, 361
paragraph text, formatting, 106
Paste Special for, 100-101
for rollover images, 159
selecting, 98-99
selection, finding text by, 119
Set Text behavior, 362
setting properties, 82
Status bar

displaying text wotj, 362-363
selecting with, 99

URL to text, applying, 413
text fields/text areas. See also forms

displaying text in, 362
spry validation widgets, 382

text files, 79
text messages, displaying, 362-363
themes, 4

sample pages with, 25

third-party file comparison tool, 496-497
thumbnails for photo albums, 287
tiling Document window, 39
times, adding, 97
Times New Roman font, 91
titles

frameset page title, setting, 275
for photo albums, 286
for text links, 169
Web page titles, changing, 85

toolbars, 41, 43
Coding toolbar, 332-333
showing/hiding, 44
working with, 44

tooltips, adding, 385
spry tooltip, 386-387

tracing images, 86
frame tracing image, changing, 272
in tables, 206-207

Traditional Point/Pica size, 55
transparency for images, 149
transparent GIFs, 256
triple-clicking on text, 98
troubleshooting plug-ins, 295
type editing, 124

U
underline style popups, 83
undoing/redoing, 126-127. See also History

panel
Undo/Redo slider, History panel, 506
Unicode normalization form, 

selecting, 63, 85
Unicode signature (BOM), selecting, 63
untitled documents, list of, 469
unused colors, removing, 149
Update Current Page method, 420
Update Pages command, 420
updating. See also links

Fireworks images, 141
library items, 420
Photoshop images, 138-139
templates, 446-447
Web updates, obtaining, 38

URL assets
displaying, 409
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image, applying URL to, 413
new URL asset, adding, 412
text, applying URL to, 413

URLs (Uniform Resource Locators). See
also Flash; Go To URL behavior; links

absolute paths and, 165
in jump menus, 317
navigation bars and, 175
opening Web page with, 28
rollover images linked to, 159
for WebDAV server, 480

UseableNet Accessibility Reference, 340
Use Dynamic Font Mapping check box, 128

V
validation, 455. See also forms

preferences, setting, 456
spry validation widgets, 382
Web pages, validating, 456-457
World Wide Web Consortium 

standards, 457
Validator, 456-457
VBScript files, 79

showing/hiding, 88
version control

Subversion, enabling, 483
views and viewing

Browser Compatibility Check (BCC)
report, 235

Design Notes, 488
download statistics, 472
Dreamweaver window, viewing, 16
Files panel, viewing files in, 70
multiple documents, viewing, 31
reports, 470
switching between views, 31
Tag Inspector views, 336
working with views, 30
Zoom tool, changing view with, 54

visibility of AP elements, 245
visitor link colors, 83
visual aids, using, 87
visually impaired persons, alternate text 

for, 467
visual server markup tags, showing and

hiding, 89

VTML files, 79

W
warnings

read-only file warnings, 60
tags, fixing or removing, 344

WAV files, linking or embedding, 288
WebDAV options, 480
Web pages. See also home page; tem-

plates; testing
blank page, creating, 21
closing, 39
custom template, creating from, 445
dynamic pages, 69
existing page, opening, 28
naming, 26
nested templates, creating from, 444
previewing, 34-35
properties, setting, 81
recently opened page, opening, 29
sample, creating from, 25
saving, 26-27
static pages, 69
switching between, 31
validating, 457

Web photo albums. See photo albums
Web-safe colors, 64
Web sites. See also testing; Web pages

for snippets, 401
for templates, 428

welcome screen, showing, 60
wheel storyboards, 9
whitespace

for ActiveX objects, 293
finding/replacing ignoring, 121
Flash/Shockwave movies, setting for, 283
for Java applets, 291
for tag find and replace, 521
for text find and replace, 519

whole word match
for tag find and replace, 521
for text find and replace, 519

widgets. See spry widgets
widths. See also tables

for ActiveX objects, 293
of AP elements, 245, 247
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Flash video settings, 284
of horizontal rules, 109
image width, changing, 144, 150
for Java applets, 291

Window-Eyes, 466
Windows Media Player, 288
Windows systems, 11

browsers on, 34
case sensitivity of file names, 27
color palette, 64
launching Dreamweaver in, 14-15
requirements for, 12

WML files, 79
tags, inserting, 337

word wrap
for form text, 306
for HTML code, 327

workflow reports, 468
workspace. See panel sets.
World Wide Web Consortium, 130

validation standards, 457
Web site, 7

wpromote Web site, 8
wrapping code, 342
wrap snippets. See snippets
Wrap Tag mode, Quick Tag Editor in, 335
WYSIWYG view, 30

X
XHTML (Extensible Hypertext Markup

Language)
cleaning up, 462-463
definitions, selecting, 62

XML (Extensible Markup Language), 29
file format, 79
spry XML data set, displaying, 390
templates, importing and exporting XML

data into, 449-450
XSL format, 29

Y
Yahoo submission options, 8

Z
Zapf Dingbats, 96
z-index to AP element, applying, 249
zooming

on images, 151
Zoom tool, 52

changing view with, 54
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